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DS-70/DS-80W User's Guide
Welcome to the DS-70/DS-80W User's Guide. 
For a printable PDF copy of this guide, click here.
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Product Basics
See these sections to learn about the basic features of your product.
Product Parts Locations
Changing the Power Save Settings
Charging the Battery (DS-80W)
Using the Epson Smart Panel Mobile App

Product Parts Locations
See these sections to identify the parts on your product.
Scanner Parts
Scanner Buttons and Lights
User Replaceable Epson Scanner Accessories
Parent topic: Product Basics

Scanner Parts

Note: The illustrations show the DS-70, but the parts are the same for the DS-80W.

1 Input slot
2 Loophole
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3 USB port

Parent topic: Product Parts Locations

Scanner Buttons and Lights
DS-70

1 start button
2 automatic feeding mode light
3 Ready light
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DS-80W

1 start button
2 automatic feeding mode light
3 Ready light
4 Wi-Fi light
5 Wi-Fi AP light
6 battery light
7 Error status light
8 Wi-Fi switch
9 Wi-Fi connect button
10 power switch

Parent topic: Product Parts Locations
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User Replaceable Epson Scanner Accessories
You can purchase genuine Epson accessories at epson.com (U.S. sales) or epson.ca (Canadian sales).
You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-
GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Part Part number
Carrier sheet for portable scanners B12B819451
Maintenance sheet kit 2 B12B819481

Parent topic: Product Parts Locations

Changing the Power Save Settings
You can use the Epson Scan 2 Utility to change the time period before the scanner enters sleep mode
and turns off automatically.
1. Do one of the following to access the Epson Scan 2 Utility:

• Windows 11: Click , then search for Epson Scan 2 Utility and select it.

• Windows 10: Click and select Epson > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

2. Click the Power Save tab.

https://www.epson.com
https://www.epson.ca
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You see a screen like this:

3. Select the length of time after which you want the scanner to go to sleep as the Sleep Timer setting.
4. Select a power off timer setting for the Battery or USB power setting (DS-80W).
5. Click Set.
6. Close the Epson Scan 2 Utility.
Parent topic: Product Basics

Charging the Battery (DS-80W)
The scanner runs on battery power when it is not connected to the computer with a USB cable, or if it is
connected via Wi-Fi. You can charge the battery from a computer with a USB connection to the scanner.
1. Make sure that the computer is turned on and not in sleep mode.
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2. Connect the scanner to the computer using the micro USB cable that came with the scanner.

3. Slide the power switch to turn on the scanner.

The battery light flashes and shows the battery level while the battery is charging. When charging
is complete, the battery level is shown as full. If the scanner is off when charging completes, the
battery light turns off.

Note: The battery takes about 3.5 hours to fully charge. Charging times increase if the scanner is on
during the charging process.

Parent topic: Product Basics

Using the Epson Smart Panel Mobile App
Use this free Apple and Android app to scan with networked Epson products (DS-80W).

Note: Epson Smart Panel does not support scanning with a carrier sheet or scanning long papers or
long receipts.

1. Connect your product to your wireless network. See the link below.
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2. Visit epson.com/connect (U.S.) or epson.ca/connect (Canada) to learn more about Epson Smart
Panel and check the compatibility of your mobile device.

3. Download Epson Smart Panel from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network as your product.
5. Open Epson Smart Panel and select your Epson product, if necessary.
Now you are ready to scan with your mobile device and your Epson product.
Parent topic: Product Basics
Related concepts
Connecting to an Existing Wi-Fi Network

https://www.epson.com/connect
https://www.epson.ca/connect
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Loading Originals
Follow the instructions here to load your originals into the product.
Loading Originals in the Input Slot
Original Document Specifications
Receipt Specifications
Special Original Specifications
Plastic Card Specifications

Loading Originals in the Input Slot
You can load an original that meets the document specifications in the input slot.

Caution: Do not load photos, or valuable original documents or artwork, directly into the scanner. This
may wrinkle or damage the original.

Note: The illustrations show the DS-70 model, but the steps are the same for the DS-80W.

• For standard size originals, slide your original into the input slot against the left side as shown until it
meets resistance. Make sure the printed side is faceup and top edge first.
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• For longer originals, slide your original into the input slot against the left side as shown until it meets
resistance. Make sure the printed side is faceup and top edge first. Set the paper size in the scanning
program and support the original as it enters into and ejects from the scanner.

Note: Epson Smart Panel does not support scanning long papers.
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• For receipts, support the original by hand and load it into the input slot against the left side as shown
until it meets resistance. Make sure the printed side is faceup and top edge first.

Note: Epson Smart Panel does not support scanning long receipts.
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• For envelopes, slide the original into the input slot against the left side as shown until it meets
resistance. Make sure the side you want to scan is faceup and the flap is facing either the right or left
side. For envelopes with the flap on the shorter side, load the envelope with the flap side last.

Caution: Do not load envelopes with adhesives on them.
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• For plastic cards, load the card horizontally into the input slot against the left side as shown until it
meets resistance. Make sure the printed side is faceup.

Caution: Do not load plastic cards vertically or at an angle.

• For irregularly shaped originals, use an optional carrier sheet (part number B12B819451). Make sure
the illustration on the front edge of the carrier sheet is faceup with the original faceup against the left
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side. Slide the carrier sheet top edge first into the input slot against the left side as shown until it meets
resistance.

Note: Only use the carrier sheet designed for your scanner. If the carrier sheet is scratched or has
been scanned more than 3,000 times, stop using it and obtain a new one. Epson Smart Panel does
not support scanning with a carrier sheet.
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Parent topic: Loading Originals
Related references
Original Document Specifications
Receipt Specifications
Special Original Specifications
Plastic Card Specifications
User Replaceable Epson Scanner Accessories

Original Document Specifications
You can load original documents that meet these specifications in your scanner.

Note: To scan delicate originals or originals that are easily wrinkled, use an optional carrier sheet (part
number B12B819451). Epson Smart Panel does not support scanning with a carrier sheet.

Paper type Paper size Paper weight
Plain paper
Fine paper
Recycled paper

Letter (8.5 × 11 inches [216 × 279 mm]) 9 to 72 lb (35 to 270 g/m²)
Legal (8.5 × 14 inches [216 × 356 mm])
A4 (8.3 × 11.7 inches [210 × 297 mm])
A5 (5.8 × 8.2 inches [148 × 210 mm])
B5 (7.2 × 10.1 inches [182 × 257 mm])
B6 (5 × 7.2 inches [128 × 182 mm])
A6 (4.1 × 5.8 inches [105 × 148 mm])
A7 (2.9 × 4.1 inches [74 × 105 mm])
A8 (2.1 × 2.9 inches [52 × 74 mm])

12 to 72 lb
(46 to 270 g/m²)

Long paper Width: 2.0 to 8.5 inches (50.8 to 216 mm)
Height: 2.0 to 72 inches (50.8 to 1828.8
mm)

9 to 72 lb (35 to 270 g/m²)

Postcards 3.9 × 5.8 inches (100 × 148 mm) 9 to 72 lb (35 to 270 g/m²)
Paper business cards 2.1 × 3.4 inches (55 × 89 mm) 12 to 72 lb

(46 to 270 g/m²)
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Note: Epson Smart Panel does not support scanning long papers.

Caution: Do not load the following types of originals in the scanner, or they may be damaged or may
damage the scanner:
• Originals with an uneven surface such as letterhead paper
• Originals with crinkles or fold lines
• Curled originals
• Coated paper
• Originals with punch holes
• Originals with folded corners
• Photos or photo paper*
• Originals with labels or stickers*
• Originals with staples or paper clips
• Originals with sticky notes attached*
• Ripped originals*
• Originals with carbon paper backing*
• Perforated originals*
• Booklets
• Non-paper originals such as clear files, fabric, and metal foil
• Originals with glue attached
• Heavily wrinkled or curled originals
• Transparent originals such as overhead projector film
• Originals with wet ink
*You can only scan these originals by using the carrier sheet.

Note: Photos scanned using a document scanner may not have the same color depth as the original.
Use a flatbed photo scanner for best results.

Parent topic: Loading Originals
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Receipt Specifications
You can load 1 receipt at a time that meets these specifications in your scanner.

Paper type Paper size Paper thickness
Receipts Width: 2.0 to 8.5 inches (50.8 to

216 mm)
Length: 2.0 to 72 inches (50.8 to 1828.8
mm)

14 to 20 lb (53 to 77 g/m²)

Note: Epson Smart Panel does not support scanning long receipts.

Parent topic: Loading Originals

Special Original Specifications
You can load 1 envelope or irregularly shaped original that meets these specifications in your scanner.

Paper type Paper size Paper thickness
Envelopes 4.72 × 9.25 inches (120 × 235 mm)

3.62 × 6.50 inches (92 × 165 mm)
0.015 inch (0.38 mm) or less

Irregularly shaped original (in
carrier sheet)

Up to A4 (8.3 × 11.7 inches
[210 × 297 mm])

0.012 inch (0.3 mm) or less
(excluding the thickness of
the carrier sheet)

Parent topic: Loading Originals

Plastic Card Specifications
You can load 1 plastic card that meets these specifications in your scanner.

Card type Card size Card thickness
With embossing ISO7810 ID-1 compliant: 2.1 × 3.3

inches (54 × 85.6 mm)
0.05 inch (1.24 mm) or less

Without embossing 0.04 inch (1.0 mm) or less
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Note: ISO7810 ID-1 size laminated cards (thickness of 0.02 inch [0.6 mm] or less) may not be scanned
successfully.

Parent topic: Loading Originals
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Wi-Fi Networking
See these sections to use your scanner over a Wi-Fi network (DS-80W).
Network Security Recommendations
Connecting to an Existing Wi-Fi Network
Setting Up Wireless Scanning from a Smart Device Using Epson Smart Panel
Direct Wi-Fi Mode Setup
Disabling Wi-Fi
Restoring Default Network Settings

Network Security Recommendations
To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.
Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:
• Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

• Connect your product only to a network protected by a firewall
Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

• Change the default administrator password on your product
If your product has an option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi Networking
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Connecting to an Existing Wi-Fi Network
You can set up your product to communicate with your computer using a wireless router. The wireless
router can be connected to your computer over a wireless or wired network.

1 Epson product
2 Wireless router
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection from the computer to the wireless router)

Manually Connecting to a Wi-Fi Network
Wi-Fi Protected Setup (WPS)
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Parent topic: Wi-Fi Networking

Manually Connecting to a Wi-Fi Network
You can use your product's software installer to connect the scanner to a Wi-Fi network.

Note: You must have a computer with a wireless adapter to set up the connection.

1. See the Start Here sheet for instructions on downloading and installing your scanner's software.

Note: The scanner powers off after 1 minute of inactivity. If the scanner turns off during the
procedure, you may need to repeat some of the steps.

2. Select the wireless connection method for the scanner when prompted.
The scanner is added to the network and connected to the computer for network scanning.

Parent topic: Connecting to an Existing Wi-Fi Network

Wi-Fi Protected Setup (WPS)
If your network uses a WPS-enabled wireless router, you can quickly connect your product to the
network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router. If there is
no hardware button, there may be a WPS setting in the software for the device. Check your network
product documentation for details.

Using WPS to Connect to a Network
Using WPS PIN Mode to Connect to a Network
Parent topic: Connecting to an Existing Wi-Fi Network

Using WPS to Connect to a Network
If you have a WPS-enabled wireless router, you can use Wi-Fi Protected Setup (WPS) to connect your
scanner to the network.
1. Follow the instructions on the Start Here sheet to install the scanner software on your computer.
2. Make sure the scanner is turned on.
3. Set the Wi-Fi switch to the Wi-Fi position.
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4. Enable WPS on your router by pressing the WPS button or enabling the WPS setting in your router
firmware.
The router enters WPS discovery mode for 2 minutes.

5. Press and hold the Wi-Fi connect button on the scanner until the ready, Wi-Fi, and Wi-Fi
AP lights flash alternately.

Note: If you do not complete this step within 2 minutes, repeat these steps to try again.

When the ready, Wi-Fi, and Wi-Fi AP lights on the scanner stay on, the scanner is
connected to the network.

Note: If the ready light stays on, but the Wi-Fi and Wi-Fi AP lights flash simultaneously,
connection has failed. Restart the scanner and router, move them closer together, and repeat these
steps to try again.

Parent topic: Wi-Fi Protected Setup (WPS)
Using WPS PIN Mode to Connect to a Network

If you have a WPS-enabled wireless router that supports PIN mode, you can use Wi-Fi Protected Setup
(WPS) PIN mode to connect your scanner to the network.
1. Follow the instructions on the Start Here sheet to install the scanner software on your computer.
2. Find the WPS PIN number setting in your router's firmware.
3. Make sure the scanner is turned off and set the Wi-Fi switch to the Wi-Fi position.
4. Press and hold the Wi-Fi connect button and slide and hold the power switch for about ten

seconds until the ready, Wi-Fi and Wi-Fi AP lights flash alternately.
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The scanner enters WPS discovery mode for two minutes.
5. Use your computer to enter the PIN code 01234565 into the WPS PIN number setting in the router

firmware within two minutes.

Note: If you do not enter the code within 2 minutes, repeat the steps to try again.

Connection setup starts when the ready light flashes, and the Wi-Fi and Wi-Fi AP lights flash
alternately. When the ready, Wi-Fi, and Wi-Fi AP lights on the scanner stay on, the scanner
is connected to the network.

Parent topic: Wi-Fi Protected Setup (WPS)

Setting Up Wireless Scanning from a Smart Device Using Epson Smart
Panel

You can use the Epson Smart Panel app to connect your Epson product to a wireless network or
connect your smart device directly to the product. Epson Smart Panel is available on iOS and Android
devices.
Make sure you have the following:
• A device that is connected to a wireless network
• The Epson Smart Panel app installed on the device
• The wireless network name (SSID) and password
1. Make sure the product is turned on and is ready to scan.

Note: You must perform initial setup before setting up wireless scanning.

2. Open the Epson Smart Panel app on your device.
3. Do one of the following:

• If the app automatically recognizes the product, follow the on-screen instructions to set up the
wireless connection.

• If the app does not automatically recognize the product, select the + icon and continue with the
next step.

4. On the next screen, select Connect to a New Product.
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5. Select your product from the list.

Note: If your product is not listed, move closer to the product and try again. If the product is still not
shown, connect your scanner to the wireless network again and then select Connect to Existing
Product in the Epson Smart Panel app and follow the on-screen instructions. See the link below for
wireless setup instructions.

6. Select Next to select the current wireless network.

Note: If you want to connect the product to a different wireless network, select Change another Wi-
Fi SSID.

7. Enter the password for the wireless network and select OK.
The app starts configuring the product.

Your product is now connected to a wireless network and set up for use with the Epson Smart Panel
app.
Parent topic: Wi-Fi Networking
Related tasks
Using the Epson Smart Panel Mobile App
Starting a Scan from a Smartphone or Tablet
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Direct Wi-Fi Mode Setup
You can set up your scanner to communicate directly with your computer or another device without
requiring a wireless router. If your product is not already connected to a wireless network, it enters
access point mode and the scanner itself acts as the network access point.

1 Epson scanner
2 Computer with a wireless interface
3 Other wireless device

Enabling a Direct Wi-Fi Connection
Parent topic: Wi-Fi Networking

Enabling a Direct Wi-Fi Connection
You can enable a direct Wi-Fi connection to allow direct communication between your scanner and
computer or other devices without a wireless router.

Note: While you are connected to the scanner, your computer cannot access the internet.

1. Set the Wi-Fi switch on the scanner to the Wi-Fi position.
2. Turn on the scanner.
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3. From your computer or device, search for and select the SSID shown on the label on the bottom of
the scanner.

Note: It may take a few minutes for the scanner SSID to appear in the list.

4. Enter the password shown on the label on the bottom of the scanner.
The computer connects to the scanner's wireless network. If the connection is unsuccessful, make
sure you entered the password correctly.

Parent topic: Direct Wi-Fi Mode Setup

Disabling Wi-Fi
You may need to disable your product's Wi-Fi if you need to solve a problem with your network
connection.

Note: Before disabling Wi-Fi, make a note of any network settings selected for Epson Smart Panel.

Set the Wi-Fi switch on the scanner to the off position.
Parent topic: Wi-Fi Networking

Restoring Default Network Settings
If you need to solve a problem with your network connection, you can restore all network settings to their
defaults.
1. Make sure the scanner is turned off.
2. Set the Wi-Fi switch on the scanner to the Wi-Fi position.
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3. Press and hold the Wi-Fi connect and start buttons and slide and hold the power switch for
about ten seconds to turn on the scanner.

The Wi-Fi and Wi-Fi AP lights flash alternately and the ready light flashes. The default
network settings are restored when the lights stop flashing.

Parent topic: Wi-Fi Networking
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Scanning
You can scan your originals and save them as digital files.
Starting a Scan
Scanning with Document Capture Pro in Standard View - Windows
Scanning with Document Capture Pro in Simple View - Windows
Scanning with Document Capture - Mac
Scanning in Epson Scan 2
Scan Resolution Guidelines
Scanning Special Projects

Starting a Scan
After placing your originals on your product for scanning, start scanning using one of these methods.
Starting a Scan from a Scanner Button
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smartphone or Tablet
Parent topic: Scanning

Starting a Scan from a Scanner Button
You can scan using the start button on your scanner. This automatically starts Document Capture Pro
(Windows) and Document Capture (Mac) and the scan job you have assigned to the button.

Note: You cannot scan using the start button on your scanner over a wireless connection. Connect
the scanner to the computer with the USB cable before scanning from the start button (DS-80W).

1. Make sure the scanner is connected to the computer with the USB cable.
2. Load an original in your scanner.
3. Press the start button.

The scanner starts the job that was assigned to the start button in Document Capture Pro
(Windows) or Document Capture (Mac).
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Note: You can view or change the scan settings using Document Capture Pro (Windows) or
Document Capture (Mac).

Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Assigning Start Button Settings or Scan Jobs - Mac
Parent topic: Starting a Scan

Adding and Assigning Scan Jobs with Document Capture Pro - Windows
You can view, change, or add available default scan settings when you scan using the start button on
your product. You do this by accessing the scan jobs in the Document Capture Pro program.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Do one of the following to start Document Capture Pro:

• Windows 11: Click , then search for Document Capture Pro and select it.

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
2. If you see a Switch to Simple View button in the upper right corner of the window, click it.
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You see a window like this:

3. Click the Job Settings button.

Note: If you do not see the button, click the < symbol in the Job bar.
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You see a window like this:

4. To add a scan job, click the New Job icon, enter a name for the new job, select settings as
necessary, and click OK.
You can now use the new scan job when you scan with Document Capture Pro.

Note: See the Help information in Document Capture Pro for details.

5. To assign a scan job to the start button, click the Button Assignment icon.

6. Select the job that you want to assign to the start button from the drop-down list.
7. Click OK, then click OK again.

You can now use the assigned scan job when you scan with the start button on your product.
Parent topic: Starting a Scan from a Scanner Button

Assigning Start Button Settings or Scan Jobs - Mac
You can view or change the default scan settings when you scan using the start button on your
scanner. You do this by accessing the scan jobs in the Document Capture program.
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1. Start Document Capture on a computer connected to the product.

2. Click the Manage Job icon from the toolbar at the top of the window.
You see a window showing the current scan job list.

3. If you want to add a scan job, click Add or the + icon, enter a name for the new job, select settings
as necessary, and click OK.
You can now use the new scan job when you scan with Document Capture.

Note: See the Help information in Document Capture for details.

4. If you want to assign a scan job to the start button, click the icon at the bottom of the
window and click Event Settings.

5. Select the job that you want to assign to the start button.

6. Click OK.
Parent topic: Starting a Scan from a Scanner Button
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Starting a Scan Using the Epson Scan 2 Icon
You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

• Windows 11: Click , then search for Epson Scan 2 and select it.

• Windows 10: Click and select EPSON > Epson Scan 2.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan

Starting a Scan from a Scanning Program
You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; not all scan functions will be available.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan

Starting a Scan from a Smartphone or Tablet
You can use the Epson Smart Panel app to scan from a network scanner to an iOS or Android device
over a direct Wi-Fi connection (DS-80W).

Note: Epson Smart Panel does not support scanning with a carrier sheet or scanning long papers or
long receipts.

1. Download the Epson Smart Panel app from your device's app store or from Epson's website. See
the link below.

2. Place your original on the product for scanning.
3. Open the Epson Smart Panel app and select a scan menu on the home screen.
4. Follow the on-screen instructions to scan and save your original.
Parent topic: Starting a Scan
Related tasks
Using the Epson Smart Panel Mobile App

Scanning with Document Capture Pro in Standard View - Windows
You can use Document Capture Pro in Standard View to select settings, preview, and change the
scanned file settings as necessary.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 11: Click , then search for Document Capture Pro and select it.

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.
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You see the Document Capture Pro window. (You may see a screen asking you to select your
scanner first; if you do, select your product.)

3. If you see a Switch to Standard View button in the upper right corner of the window, click it.
You see a window like this:

4. Select Scan Settings from the Scan Setting Name list (or select Scan > Scan Settings from the
menu bar).
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You see a window like this:

5. Select any displayed settings you want to use and click OK.

Note: See the help information in Document Capture Pro for details.

6. Click Scan.
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You see a preview of your scan in the Document Capture Pro window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
Pro window.

7. If you would like to scan additional originals and add them to the current captured images, click the

Add Page(s) icon and follow the instructions on the screen.
8. Check the scanned images and edit them as necessary.

Note: See the help information in Document Capture Pro for details.

9. Click one of the Destination icons to choose where to send your scanned files. (If you cannot see all
of the icons below, click the arrows next to the icons.)

10. Depending on the destination you chose, click OK or Send to complete the scan.
Parent topic: Scanning
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Scanning with Document Capture Pro in Simple View - Windows
You can use Document Capture Pro in Simple View to quickly select options and scan.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 11: Click , then search for Document Capture Pro and select it.

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window. (You may see a screen asking you to select your
scanner first; if you do, select your product.)

3. If you see a Switch to Simple View button in the upper right corner of the window, click it.
You see a window like this:
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4. Click Select Scanner and select your scanner from the scanner list, if necessary.
5. If you want to use a scan job, click one of the job icons in the Job section of the window to complete

and send your scan with one click.

Note: If you do not see any icons, click the < symbol in the Job bar.

6. If you want to select scan settings for a particular destination, click the Scan Settings button, select
any displayed settings you want to use, and click OK.

Note: See the help information in Document Capture Pro for details. If you do not see the Scan
Settings button, click the < symbol in the Scan and... bar.

7. Click one of the destination icons in the Scan and... section of the window. Your product starts
scanning and you see the settings window.
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8. Select any destination settings as necessary and click OK.

Note: See the help information in Document Capture Pro for details.

9. Confirm your settings and click OK or Close.
Parent topic: Scanning

Scanning with Document Capture - Mac
When you scan with Document Capture, the program automatically saves your scanned file on your
computer in the folder you specify. You can select settings, preview, and change the scanned file
settings as necessary.

Note: Settings may vary depending on the software version you are using. See the Help menu in
Document Capture at any time for more information.

1. Load your original in the product.
2. Open the Applications folder, open the Epson Software folder, and select Document Capture.

You see a window like this:

Note: You may need to select your scanner from the scanner list.
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3. Click the scan icon.
You see a window like this:

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

6. Click the Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.
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7. Click Scan.
You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.
10. Click one of the destination icons to choose where to send your scanned files. (If you cannot see all

of the icons below, click the arrow next to the icons.) Change any settings as necessary.

Note: If you are sending the scanned image to a server or cloud destination, you need to enter your
login information.

11. Depending on the destination you chose, click OK or Send to complete the operation.
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Parent topic: Scanning

Scanning in Epson Scan 2
Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document
and save the scanned image in various file formats in your operating system's Documents or My
Documents folder, or open it in your scanning program. You can preview the scanned image and select
or change settings as necessary.
1. Load your original in the product.
2. Start Epson Scan 2.
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You see this window:
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Note: The Document Source setting is automatically set to ADF for your product.

3. If you want to scan different size originals by loading them into the input slot one by one, check the
Automatic Feeding Mode checkbox and click Scan. Scanning begins as soon as you load each
original.

4. Select the Document Size setting that matches the size of your original, or select Auto Detect to
have Epson Scan 2 automatically detect the size. You can select Customize to enter a custom size,
if necessary.

5. Select your original image type and how you want it scanned as the Image Type setting.
6. Select the Resolution setting you want to use for your scan.
7. Select any of the additional settings that you want to use on the Main Settings tab.
8. Click the Advanced Settings tab and select any settings that you want to use.
9. To see a preview of your scan with the settings you selected, click the Preview button.

Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.
10. Select the format in which you want to save your scanned file as the Image Format setting. If

necessary, select Options and select any desired format options.
11. Select Settings to modify the file name settings. Enter the file name for your scanned file in the File

Name field.
12. Select the location in which you want to save your scanned file as the Folder setting. If necessary,

select Select to choose an alternate folder or create a new folder.
13. Click Scan.

The product scans your original and saves the scanned file in the location you specified.
14. If you selected the Automatic Feeding Mode setting, place your next original in the input slot for

scanning. When you finish scanning originals, click Finish.
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
Scanning Settings for Special Documents
Image Format Options
Parent topic: Scanning
Related tasks
Loading Originals in the Input Slot
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Additional Scanning Settings - Main Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Main Settings tab.
Rotate

Rotates the original image clockwise to the desired angle before scanning it. Select Auto to allow
your product to automatically rotate the image based on the orientation of the text (may take longer to
scan).

Correct Document Skew
Corrects skewed originals, image contents, or both.

Add or edit pages after scanning
Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.

Parent topic: Scanning in Epson Scan 2
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Additional Scanning Settings - Advanced Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen or your scanner's
features.
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Remove Background
Removes the background from your originals.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.

Dropout
The scan will not pick up the color you select. This setting is available only if you select Grayscale or
Black & White as the Image Type setting.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Remove Punch Holes
Removes the shadows caused by holes on the edges of the original.

Dual Image Output
Scans the original image twice using different output settings (Windows only).
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Parent topic: Scanning in Epson Scan 2

Scanning Settings for Special Documents
You need to select specific options on the Main Settings tab in Epson Scan 2 when scanning special
originals.

Type of original Required settings
Envelopes Select Auto as the Rotate setting.
Plastic cards Select Plastic Card as the Document Size setting.
Large originals If the Document Size list does not contain the document size

you want to scan, select Customize to create a custom
size.

Long paper If the Document Size list does not contain the document size
you want to scan, select Auto Detect (Long Paper) or
select Customize to create a custom document size up to
72 inches (1828.8 mm).

Parent topic: Scanning in Epson Scan 2

Image Format Options
You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.
BITMAP (*.bmp)

A standard image file format for most Windows programs.
JPEG (*.jpg)

An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.
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Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned
document can be searched.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines
The resolution setting in your scanning software, measured in dpi (dots per inch), controls the amount of
detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes
with the following disadvantages:
• Larger file sizes
• It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
• The image may become too large to fit on your display or print on paper
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by the software. Follow these guidelines to determine the
resolution setting you need:
• You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the resolution setting in your scanning software. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the resolution setting to 600 dpi.

• You will scan the image at 100% or smaller size.
Select the resolution setting based on how you will use the scanned image:
• Email/view on a computer screen/post on the web: 96 to 200 dpi
• Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

• You will scan a long original.
Scan paper up to 72 inches (1828.8 mm) in length with a maximum resolution of 300 dpi or less.

Parent topic: Scanning
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Scanning Special Projects
Your product's scanning software offers various options to help you quickly complete special scan
projects.
Scanning Multi-Page Originals as Separate Files - Windows
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
Saving Scanned Documents as a Searchable PDF with Document Capture - Mac
Saving a Scan as an Office Format File - Windows
Saving a Scan as an Office Format File - Mac
Scanning to a SharePoint Server or Cloud Service - Windows
Parent topic: Scanning

Scanning Multi-Page Originals as Separate Files - Windows
You can use Document Capture Pro (Windows) to scan multi-page originals as separate scanned files.
You indicate how the separate files are created by defining a maximum page count per file or by
inserting blank pages, barcodes, or characters that can be detected by the software as separation
markers.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Do one of the following to start Document Capture Pro:

• Windows 11: Click , then search for Document Capture Pro and select it.

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
2. If you see a Switch to Simple View button in the upper right corner of the window, click it.
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You see a window like this:

3. Click the Scan Settings button.

Note: If you do not see any icons, click the V symbol next to the Job Settings button.
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You see a window like this:

4. Select any displayed settings you want to use and then click Detailed Settings.

Note: See the help information in Document Capture Pro for details.
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You see a window like this:
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5. Select the Automatic Feeding Mode checkbox and click Save.
6. Click OK in the Scan Settings window.
7. Click one of the destination icons (except Print) in the Scan and... section of the window.
8. Load your multi-page original, one page at a time, including any separator pages, in the product.

Your product scans each page.
9. When you are finished scanning your originals, click Finish.

You see the Save Settings window.
10. Select the Apply job separation checkbox.
11. Click Separation Settings.

You see a window like this:
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12. Select the method you used to separate the originals as the Separator setting.

Note: See the help information in Document Capture Pro for details.

13. If necessary, select Create Folder and select a folder name.
14. Select any other folder naming settings you want and click OK, then click OK again.

Your originals are saved into separate files and folders as specified.
15. Click Close.
Parent topic: Scanning Special Projects

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is
recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.
1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click Preview and adjust the area you want to scan, if necessary.
5. Select Searchable PDF as the Image Format setting.
6. Select Options from the Image Format list.
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You see this window:

7. Select any of the options on the General tab.
8. Select the Text tab.
9. Make sure the language used in the document text is selected as the Text Language setting.
10. Click OK.
11. Confirm the File Name setting and select a Folder setting for your document.
12. Click Scan.

The scanned image is saved as a searchable PDF.
Parent topic: Scanning Special Projects

Saving Scanned Documents as a Searchable PDF with Document Capture - Mac
You can scan a document with Document Capture and save the text in a searchable PDF. In a
searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in
the scanned original.
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Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture for details.

1. Load your original in the product for scanning.
2. Open the Applications folder, open the Epson Software folder, and select Document Capture.

You see a window like this:

Note: You may need to select your scanner from the scanner list.

3. Click the Scan icon.



68

You see a window like this:

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

6. Click the Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

7. Click Scan.
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You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.
10. Open the File menu at the top of the Mac desktop and select Save As.
11. Select PDF as the File Type setting and click the Options button.
12. Select the Create Searchable PDF checkbox and click OK.
13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all

of the icons below, click the arrow next to the icons.)

14. Depending on the destination you chose, click OK or Send to complete the operation.
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Parent topic: Scanning Special Projects

Saving a Scan as an Office Format File - Windows
You can use Document Capture Pro (Windows) to save your scans in one of the following Microsoft
Office file formats: Microsoft Word (.docx), Microsoft Excel (.xlsx), or Microsoft PowerPoint (.pptx).

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 11: Click , then search for Document Capture Pro and select it.

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. If you see a Switch to Simple View button in the upper right corner of the window, click it.
You see a window like this:
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4. Click the Scan Settings button.

Note: If you do not see any icons, click the V symbol next to the Job Settings button.

You see a window like this:

5. Select any displayed settings you want to use and click OK.

Note: See the help information in Document Capture Pro for details.

6. Click one of the destination icons (except Print) to choose where to send your scanned files. Your
product starts scanning and you see the settings window.

7. Select the Office format file you want to use from the File Type drop-down list.

Note: The first time you select an Office format file you are prompted to download a plug-in update
for Microsoft Office files. Select Yes to download and install the plug-in.
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8. Click Option to display additional settings.
9. Select any additional settings as necessary and click OK.

Note: See the help information in Document Capture Pro for details.

10. Confirm your settings and click OK.
Your originals are saved in the Office file format you selected.

Parent topic: Scanning Special Projects

Saving a Scan as an Office Format File - Mac
You can use Document Capture (Mac) to save your scans in one of these Microsoft Office file fomats:
Microsoft Word (.docx) and Microsoft Excel (.xlsx).

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture for details.

1. Load your original in the product for scanning.
2. Open the Applications folder, open the Epson Software folder, and select Document Capture.

You see a window like this:
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Note: You may need to select your scanner from the scanner list.

3. Click the Scan icon.
You see a window like this:

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.
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6. Click the Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

7. Click Scan.
You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.
10. Open the File menu at the top of the Mac desktop and select Save As.
11. Select DOCX (Word) or XLSX (Excel) as the File Type setting.

Note: The first time you select an Office file type setting in Document Capture, you see a prompt to
download a necessary plug-in for Microsoft Office files. Select Yes and follow the on-screen
instructions to download and install the plug-in to continue.

12. Click the Options button, select any necessary Office file type options, and click OK.
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13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all
of the icons below, click the arrow next to the icons.)

14. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning Special Projects

Scanning to a SharePoint Server or Cloud Service - Windows
You can use Document Capture Pro (Windows) to upload scanned images to a SharePoint server or a
cloud service.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 11: Click , then search for Document Capture Pro and select it.

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. If you see a Switch to Simple View button in the upper right corner of the window, click it.
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You see a window like this:

4. Click the Scan Settings button.

Note: If you do not see any icons, click the V symbol next to the Job Settings button.
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You see a window like this:

5. Select any displayed settings you want to use and click OK.

Note: See the help information in Document Capture Pro for details.

6. Click one of the cloud server or service destination icons in the Scan and... section of the window.
Your product starts scanning and you see the settings window.

Note: If you cannot see all of the icons, the service software may not be installed or the service may
not be available on your platform.

7. Enter any required information to set up the destination. You may need to log in to your cloud service
to authenticate the connection and allow Document Capture Pro to access the cloud service. If you
have previously created a saved setting for the destination, select it from the drop-down list.
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8. Adjust any settings and click OK.

Note: See the help information in Document Capture Pro for details.

Your originals are uploaded to the indicated server or cloud service.
Parent topic: Scanning Special Projects
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Cleaning and Transporting Your Product
See these sections if you need to clean or transport your product.
Cleaning Your Scanner
Cleaning Inside Your Scanner
Calibrating Your Scanner
Transporting Your Scanner

Cleaning Your Scanner
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it. Do not open the product's
outer case.

1. Turn off the scanner (DS-80W).
2. Disconnect the USB cable, if connected.
3. Clean the outer case with a soft, dry cloth. Do not use liquid or chemical cleansers.

Note: If the outer case still requires additional cleaning, use a slightly damp cloth to wipe the outer
case. Then wipe the case with a soft, dry cloth.

Parent topic: Cleaning and Transporting Your Product

Cleaning Inside Your Scanner
Clean your scanner regularly using the dry cleaning sheet that came with your scanner. Dust on the
scanning surface can cause spots or lines in your scanned images. If spots or lines remain, a wet
cleaning sheet is available as part of the optional maintenance sheet kit (part number B12B819481).

Note: The illustration shows the DS-70, but the steps are the same for the DS-80W.

Caution: Use the dry or wet cleaning sheets to clean your scanner. Do not disassemble your product
and do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not
use oil or other lubricants inside the product or let water get inside it.
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You can purchase genuine Epson accessories at epson.com (U.S. sales) or epson.ca (Canadian sales).
You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-
GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.
1. Turn on the scanner and make sure it is connected to the computer.
2. Load the dry cleaning sheet into the scanner.

3. Do one of the following to start the Epson Scan 2 Utility:

• Windows 11: Click , then search for Epson Scan 2 Utility and select it.

• Windows 10: Click > Epson > Epson Scan 2 Utility
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
4. Click Maintenance.
5. Click Cleaning.

Note: Cleaning does not start if the battery level is low (DS-80W).

The scanner feeds and ejects the cleaning sheet. Cleaning takes about 30 seconds.
6. If spots or lines remain, repeat these steps to clean it again.

Note: You can use the same dry cleaning sheet multiple times.

https://www.epson.com
https://www.epson.ca
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7. If the scanner is not clean after multiple cleanings with the dry cleaning sheet, repeat these steps
using the wet cleaning sheet from the optional maintenance sheet kit.

Note: You can use the wet cleaning sheet only once. If the scanner is still not clean after using the
wet cleaning sheet, contact Epson for support.

Parent topic: Cleaning and Transporting Your Product
Related references
User Replaceable Epson Scanner Accessories

Calibrating Your Scanner
If you notice any of the following image quality problems, you can calibrate the scanner using the
calibration sheet that came with it:
• Scanned images are blurry.
• Scanned colors differ from the colors in the original.
• Scanned images are darker or lighter than the original.
• Scanned images contain vertical lines.

Note: The illustration shows the DS-70, but the steps are the same for the DS-80W.

1. Turn on the scanner and make sure it is connected to the computer.

Note: Make sure the scanner battery is not low or calibration will not start (DS-80W).

2. Load the calibration sheet into the scanner with the arrows at the trailing edge of the sheet pointing
into the input slot.
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3. Do one of the following to start the Epson Scan 2 Utility:

• Windows 11: Click , then search for Epson Scan 2 Utility and select it.

• Windows 10: Click > Epson > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
4. Click Maintenance.
5. Click Calibration.

The scanner feeds and ejects the calibration sheet. Calibration takes about 20 seconds.

Note: You can use the calibration sheet multiple times. If calibrating the scanner does not improve
the image quality, contact Epson for support.

Parent topic: Cleaning and Transporting Your Product

Transporting Your Scanner
If you need to ship your product, transport it a long distance, or store it for an extended period, prepare it
for transportation as described here.
1. Turn off the scanner (DS-80W).
2. Disconnect the USB cable, if connected.
3. Place the scanner in its original packing materials, if possible, or use equivalent materials with

cushioning around the product.

Caution: Strong impacts may damage the scanner. Do not expose the scanner to direct sunlight or
leave it near heaters or in locations subject to high temperatures. Heat may cause the body to
deform.

Note: If you are taking the scanner with you on a flight, first confirm with the airline if you can take
the scanner on the airplane. We recommend you take the scanner in your carry-on luggage as the
scanner can be damaged by a strong impact depending on how your checked luggage is handled at
the airport.
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Parent topic: Cleaning and Transporting Your Product
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Scanner Light Status
Solving Scanning Problems
Solving Network Scanning Problems
Solving Scanned Image Quality Problems
Uninstall Your Product Software
Where to Get Help - U.S. and Canada

Scanner Light Status
You can often diagnose problems with your scanner by checking its lights.
DS-70

1 Ready light
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Light status Condition/solution
The ready light is orange Check the following:

• Make sure there are no originals jammed in the scanner.
• Make sure the scanner is connected to your computer securely.
• Make sure Epson Scan 2 is installed correctly.
• If a firmware update fails and the scanner enters recovery mode,

update the firmware again using a USB connection.
• Disconnect and re-connect the USB cable to the computer. If this

does not solve the problem, the scanner may be malfunctioning or
the light source in the scanner unit may need to be replaced. Contact
Epson for support.

DS-80W

1 Wi-Fi light
2 Wi-Fi AP light
3 battery light
4 Error status light
5 Ready light
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Light status Condition/solution
The error status light shows
the letter J and the ready light
is orange

A paper jam has occurred. Remove and reload the original.

The error status light shows
the letter F and the ready light
is orange

One of the following has occurred:
• A fatal error has occurred. Turn the scanner off and on again. If the

error continues, contact Epson for support.
• The battery cannot be fully charged even if you are charging the

battery within the guaranteed charging temperature range. It may be
damaged or has reached the end of its service life. Contact Epson for
support.

The error status light shows
the letter U and the ready light
is orange

The firmware update has failed.
• Connect the computer and the scanner with a USB cable (during

recovery mode, you cannot update the firmware over a network
connection)

• Contact Epson for instructions on updating the firmware again.
The error status light shows
the letter P and the ready light
is orange

The scanner has started in recovery mode.
• Connect the computer and the scanner with a USB cable (during

recovery mode, you cannot update the firmware over a network
connection)

• Contact Epson for instructions on updating the firmware again.
The error status light shows
the letter H, and all other
lights are on

The battery stopped charging because it became too hot. Charge the
battery within an ambient temperature range of 46 to 95 °F (8 to 35 °C).

The error status light shows
the letter C, and all other
lights are on

The battery stopped charging because it became too cold. Charge the
battery within an ambient temperature range of 46 to 95 °F (8 to 35 °C).

The Wi-Fi and Wi-Fi
AP lights flash simultaneously

An access point settings error has occurred. Restart the scanner and
router, move them closer together, and connect to the network again.

Parent topic: Solving Problems
Related references
Original Jams in Scanner
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Where to Get Help - U.S. and Canada
Related tasks
Loading Originals in the Input Slot
Charging the Battery (DS-80W)
Related topics
Scanning
Wi-Fi Networking

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.
Scanner Does Not Turn On or Off or Turns Off Unexpectedly
Scanner Button Does Not Work as Expected
Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Original Feeds Incorrectly in Scanner
Original Jams in Scanner
Scanning is Slow
Cannot Send Scans to a Cloud Service
Parent topic: Solving Problems

Scanner Does Not Turn On or Off or Turns Off Unexpectedly
If the scanner does not turn on or off or if it turns off unexpectedly, try these solutions:
• Wait a second after connecting the USB cable. It may take a few seconds until the scanner turns on.
• If the scanner turns off unexpectedly, you may need to adjust the Power Save settings.
• Use the scanner within the operating temperature range. The scanner may turn off suddenly under low

or high temperatures.
• Use the USB cable that came with the scanner.
• Make sure the USB cable is securely connected to the scanner and the computer.
• Connect the scanner directly to the computer. The scanner may not work properly when connected

through a USB hub.
• If the scanner is running on the battery under temperatures that are too low or too high, the scanner

will not turn on. Use the scanner within the operating temperature range (DS-80W).
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• Make sure the battery has enough power (DS-80W).
• Make sure the Wi-Fi switch is in the Wi-Fi position or connect to the computer using the USB

cable. Otherwise, the scanner may turn off (DS-80W).
• If the scanner does not turn off when running on the battery, disconnect the USB cable and press the

reset button on the bottom of the scanner (DS-80W).

Parent topic: Solving Scanning Problems
Related tasks
Changing the Power Save Settings
Charging the Battery (DS-80W)

Scanner Button Does Not Work as Expected
If the scanner button does not start the correct program or perform the correct action, try these solutions:
• You cannot scan using the start button over a wireless connection. Connect the scanner using a

USB cable before scanning from the button on your scanner (DS-80W).
• Check the USB cable connection between the computer and scanner.
• Check that the correct scanner is selected using the Epson Scan 2 Utility.
• In Windows, be sure that the scanner is listed under Imaging Devices in the Device Manager.
• Make sure you have assigned the correct job to the scanner button and change it, if necessary.
• Check the status of the lights and make sure the scanner is ready to scan.
• Make sure Epson Scan 2 and other applications are installed correctly. If necessary, uninstall and

reinstall it.
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Parent topic: Solving Scanning Problems
Related references
Scanner Light Status
Related tasks
Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Assigning Start Button Settings or Scan Jobs - Mac

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your

operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart your scanning software.
• Make sure the product is turned on.
• Make sure the connection between the product and your computer is secure.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, be sure that the product is listed under Imaging Devices in the Device Manager.
• Make sure the scanning software is installed.
• Use the USB cable that came with the scanner.
• Connect the product directly to the computer. The product may not work properly when connected

through a USB hub/switch.
• If you are using a TWAIN-compliant program, make sure that the correct product is selected as the

Scanner or Source setting.
• Check that the Wi-Fi connection is working correctly. Try turning the wireless router off and on (DS-

80W).
• Make sure another computer is not connected to the scanner using a USB cable. A USB connection

takes priority over a Wi-Fi connection. If another computer is connected by USB, disconnect it.
• If you are using a Mac computer, make sure you select the network that has priority on it.
Parent topic: Solving Scanning Problems
Related references
Windows System Requirements
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Mac System Requirements
Related tasks
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:
• Make sure to use the USB cable that came with the scanner.
• Make sure your scanner is turned on and any interface cables are securely connected at both ends.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart Epson Scan 2.
• Connect the scanner directly to the computer. The scanner may not work properly when connected

through a USB hub.
• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
• If you are using a TWAIN-compliant program, make sure that the correct product is selected as the

Scanner or Source setting.
• Make sure the ready light stops flashing, indicating that the scanner is ready to scan.
Parent topic: Solving Scanning Problems
Related references
Windows System Requirements
Mac System Requirements
Scanner Light Status
Related tasks
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Original Feeds Incorrectly in Scanner
If you have problems feeding originals in your scanner, try these solutions:
• Load only an original that meets the specifications for your scanner.
• Clean inside the scanner using a cleaning sheet.
Parent topic: Solving Scanning Problems
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Related references
Original Document Specifications
Receipt Specifications
Special Original Specifications
Plastic Card Specifications
Related tasks
Loading Originals in the Input Slot
Cleaning Inside Your Scanner

Original Jams in Scanner
If an original has jammed inside the scanner, follow these steps:
1. Gently pull out the jammed original in the direction that offers the least resistance.

Note: Pull the jammed original gently, otherwise it could be damaged. If paper gets stuck in the roller
and remains inside the scanner, carefully remove it with a pair of tweezers in the direction of the
output slot. If you cannot remove it, contact Epson for support.

2. Carefully follow all loading instructions when you reload your original.

Note: Epson Smart Panel does not support scanning long papers.
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Parent topic: Solving Scanning Problems
Related references
Original Document Specifications
Receipt Specifications
Special Original Specifications
Plastic Card Specifications
Where to Get Help - U.S. and Canada
Related tasks
Loading Originals in the Input Slot
Cleaning Inside Your Scanner

Scanning is Slow
If scanning becomes slow, try these solutions:
• Scan your original at a lower resolution, if possible.
• Make sure your system meets the requirements for your operating system. If you are scanning a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory or reduce the resolution.

• If you are scanning over a wireless network, factors such as interference, network traffic, or weak
signal strength may affect your scanning speed (DS-80W).

• Computers with USB 2.0 (Hi-Speed) ports can scan faster than those with USB 1.1 ports. If you are
using a USB 2.0 port with the scanner, make sure it meets the system requirements.

• Scanning may take longer if the battery is low. Charge the battery from a computer with a USB
connection (DS-80W).

Parent topic: Solving Scanning Problems
Related references
Windows System Requirements
Mac System Requirements

Cannot Send Scans to a Cloud Service
If you cannot send a scan to a cloud service, try these solutions:
• Make sure your computer is connected to the internet.
• Make sure the login information you entered for the cloud service is correct.
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• Make sure the cloud service is not down for system maintenance. Check the cloud service website for
more information.

Parent topic: Solving Scanning Problems

Solving Network Scanning Problems
Check these solutions if you have problems scanning over a network (DS-80W).
Cannot Scan Over a Network
Product Cannot Connect to a Wireless Router or Access Point
Parent topic: Solving Problems

Cannot Scan Over a Network
If you have problems scanning over a network (DS-80W), try these solutions:
• Make sure the Wi-Fi switch is set to the Wi-Fi position.
• Make sure the computer and scanner are connected to the same network (or network subnet/VLAN).
• Move the scanner and computer or smart device closer to the access point.
• If you cannot scan from the start button on the scanner, make sure you restarted your computer

after installing the scanning software.
• You cannot start a scan from the start button over a wireless network. Connect the scanner using a

USB cable before scanning from the start button (DS-80W).
• If you are scanning a large original at a high resolution, a network communication error may occur. Try

scanning again at a lower resolution.
• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few

seconds, and restart the program. If Epson Scan 2 cannot restart, turn off your scanner, turn it back
on, and try starting Epson Scan 2 again.

• Check the network connection setting in the Epson Scan 2 Utility.
• You may need to disable the firewall and any anti-virus software on your wireless router or access

point.
• If you see the message "Network product is not available: currently being used by user", there may be

a communication error between the scanner and computer. Restart the scanner.
• Epson Scan 2 does not support networks that use only IPv6. Use Epson Scan 2 on a network that

supports IPv4.
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• If the Firewall function is active, the scanner may not be discovered by the Epson Scan 2 Utility. Open
the Epson Scan 2 Utility, enter the IP address for your scanner, and click Add.

• If the scanner and computer cannot communicate and are connected to the same network (subnet or
VLAN), check if your router uses the privacy separator and disable it, if necessary. Follow the
instructions in your router documentation to disable the privacy separator.

Parent topic: Solving Network Scanning Problems
Related topics
Wi-Fi Networking

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point (DS-80W), try these
solutions:
• If you did not successfully connect to a network while installing your product software, select the link at

the end of this topic and follow the steps in "Manually Connecting to a Wi-Fi Network."
• If you are connecting the product via Wi-Fi Protected Setup (WPS), make sure you activate WPS on

your product within 2 minutes of activating WPS discovery mode on the router by pressing the WPS
button or enabling the WPS setting in your router firmware.

• Make sure to place your product within contact range of your router or access point. Avoid placing
your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing
cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions. Be sure to connect your computer and scanner only to a 2.4 GHz network name (SSID).

• Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

• You may need to temporarily disable your firewall and any anti-virus software on your wireless router
or access point. Then try scanning again. You can also unblock your product driver or network
address in your firewall or anti-virus software.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, check the label on the back or bottom of your product. Then
follow the instructions in your router or access point documentation to add the address to the list.
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• If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

• The product may not be able to communicate with a computer with both Ethernet and Wi-Fi adapters
enabled. Disable all network interfaces except for the interface connected to the product.

• Enable the DHCP function on the router or access point.
• Check that the product's IP address is set correctly.
Parent topic: Solving Network Scanning Problems
Related tasks
Manually Connecting to a Wi-Fi Network
Related topics
Wi-Fi Networking

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.
Back of Original Image Appears in Scanned Image
Scanned Characters are Blurry
Characters are not Recognized During Conversion to Editable Text (OCR)
Ripple Patterns Appear in an Image
Spots or Lines Appear in All Scanned Images
Scanned Image is Cropped
Resetting the Epson Scan 2 Settings
Parent topic: Solving Problems

Back of Original Image Appears in Scanned Image
If an image from the back of a thin original appears in your scanned image, make sure you selected the
correct Image Type setting for your original and select the Text Enhancement setting in Epson Scan 2.
You can also select the Remove Background setting in Epson Scan 2.
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Note: If you select Color as the Image Type setting, you can change the level from Standard to High to
remove more of the background.

Parent topic: Solving Scanned Image Quality Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Scanned Characters are Blurry
If characters in your scanned images are blurry, try these solutions:
• Make sure you do not move the product or original while scanning.
• Operate the product on a flat, stable surface.
• Make sure the originals are ejecting properly.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the Text Enhancement setting.
• If the Image Type setting is Black & White, adjust the Threshold setting.
• Increase the Resolution setting.
• Set the Image Type to Grayscale.
• If you are scanning in JPEG format, change the compression level. Click Options in the Image

Format menu and change the Image Quality setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Characters are not Recognized During Conversion to Editable Text (OCR)
If characters in your scanned images are not recognized during OCR conversion, try these solutions:
• Make sure your original is loaded straight on your product.
• Use an original with clear text.
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• Adjust these Epson Scan 2 settings (if available) and try scanning again:
• Select the correct Image Type setting.
• If the Image Type is set to Black & White, adjust the Threshold setting.
• Set the Image Type to Grayscale.

• Set the scanning resolution between 200 and 600 dpi.
• If the original document is in landscape mode, set the Rotate setting to Auto in Epson Scan 2.
• If you are using OCR software, check the manual for any additional adjustments.
• Scan thermal paper receipts as soon as possible. They may deteriorate due to age or friction.
• When saving to Microsoft Office or Searchable PDF files, check that the correct languages are

selected. Check the language in each save setting window.
Parent topic: Solving Scanned Image Quality Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Ripple Patterns Appear in an Image
You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:
• Select the Descreening setting.
• Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Spots or Lines Appear in All Scanned Images
If spots or lines appear in all your scanned images, try these solutions:
• Clean inside the scanner using a cleaning sheet.



98

• Calibrate the scanner using a calibration sheet.
• Make sure the surface of your original is clean.
• Avoid scanning in direct sunlight.

Note: If you are scanning a plastic card with a shiny surface, a line may appear in the scan.

Parent topic: Solving Scanned Image Quality Problems
Related tasks
Cleaning Inside Your Scanner
Calibrating Your Scanner

Scanned Image is Cropped
If the edges of a scanned image are cropped, try the following solutions:
• Select Auto Detect as the Document Size setting in Epson Scan 2, Document Capture Pro, or

Document Capture.
• If the document size is not detected correctly using the Auto Detect setting, select the size of your

original from the Document Size list.

Note: If the size you want to scan is not on the list, select Customize to create it manually (Windows
only).

• In Epson Scan 2, select the Main Settings tab. Select Document Size > Settings and adjust the
cropping area shown in the Crop Margins for Size "Auto" setting.

• In Epson Scan 2, select the Advanced Settings tab. Make sure the Edge Fill setting is set to None.
• Document Capture Pro (Windows): Select Scan Settings > Detailed Settings from the Scan

window. Select Document Size and then select the Auto Detect setting.

• Document Capture (Mac): Click the Scan button and select Main Settings from the Scan
window. Select Document Size and then adjust the cropping area shown in the Crop Margins for
Size "Auto" setting.

Parent topic: Solving Scanned Image Quality Problems

Resetting the Epson Scan 2 Settings
If you continue to experience image quality problems after trying all possible solutions, you may need to
reset the Epson Scan 2 settings using the Epson Scan 2 Utility.
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1. Do one of the following to start the Epson Scan 2 Utility:

• Windows 11: Click , then search for Epson Scan 2 Utility and select it.

• Windows 10: Click > EPSON > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

2. Click the Other tab.
3. Click Reset and confirm your choice.

Note: If resetting the Epson Scan 2 settings does not solve your problem, uninstall Epson Scan 2 and re-
install it.

Parent topic: Solving Scanned Image Quality Problems
Related concepts
Uninstall Your Product Software

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac
Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Exit all applications currently running on your computer.
2. Turn off the product (DS-80W).
3. Disconnect any interface cables.
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4. Do the following to uninstall each of your scanning software programs and follow any on-screen
instructions:

• Windows 11: Click , then search for Settings and select it. Select Apps or System > Apps &
features. Then select the program you want to uninstall and select Uninstall.

• Windows 10: Click and select (Settings) > Apps > Apps & features. Select the product
software program and click Uninstall.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the product software program and click Uninstall/Change.

• Windows 7: Open the Windows Control Panel utility. Select Programs and Features. (In
Classic view, select Programs and click Uninstall a program.) Select the product software
program and click Uninstall/Change.

5. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - Mac
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.
1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or

latin.epson.com/support (Caribbean) and select your product.
2. Follow the instructions on the screen to install the Uninstaller utility.
3. Quit all applications currently running on your Mac.
4. Double-click the Uninstaller icon.
5. In the Epson Uninstaller screen, select the checkbox for each software program you want to

uninstall.
6. Click Uninstall.
7. Follow the on-screen instructions to uninstall the software.
8. To reinstall your product software, see the Start Here sheet for instructions.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

http://www.epson.com/support
http://www.epson.ca/support
https://latin.epson.com/support
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Parent topic: Uninstall Your Product Software

Where to Get Help - U.S. and Canada
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at epson.com/support (U.S.), epson.ca/support (Canada), or
latin.epson.com/support (Caribbean) and select your product for solutions to common problems with
your product. You can download utilities and documentation, get FAQs and troubleshooting advice, or e-
mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:
• U.S.: (562) 276-4300, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific

Time, Saturday
• Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,

Pacific Time, Saturday
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Note: For help using any other software on your system, see the documentation for that software for
technical support.

Purchase Supplies and Accessories
You can purchase genuine Epson accessories at epson.com (U.S. sales) or epson.ca (Canadian sales).
You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-
GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.
Parent topic: Solving Problems

http://www.epson.com/support
http://www.epson.ca/support
https://latin.epson.com/support
https://www.epson.com
https://www.epson.ca
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Technical Specifications
These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S.) or
this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
General Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Network Interface Specifications (DS-80W)
Safety and Approvals Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 11
• Windows 10
• Windows 8.x
• Windows 7

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.) or epson.ca/support (Canada), select your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• macOS 12.x
• macOS 11.x

https://epson.com/recycle-program
https://www.epson.ca/recycle
http://www.epson.com/support
http://www.epson.ca/support
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• macOS 10.15.x
• macOS 10.14.x
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x

Note: The UNIX File System (UFS) for OS X is not supported.

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.) or epson.ca/support (Canada), select your product, and select Downloads.

Parent topic: Technical Specifications

General Specifications
Scanner type Portable, sheet feed, simplex (single-sided) color A4/Letter size
Photoelectric device CIS
Effective pixels 5100 × 8400 pixels at 600 dpi (maximum)

2550 × 21600 pixels at 300 dpi (maximum - long paper)
Document size Maximum: 8.5 × 72 inches (215.9 × 1828.8 mm)

Documents scanned at 301 dpi or more: up to 8.5 × 14 inches (215.9
× 355.6 mm)
Minimum: 2 × 2 inches (50.8 × 50.8 mm)

Paper input Faceup loading
Paper output Faceup ejection
Paper capacity 1 sheet of paper
Scanning resolution 600 dpi (main scan)

600 dpi (sub scan)
Output resolution 50 to 1200 dpi (in 1 dpi increments)

50 to 300 dpi for scans from 14 to 72 inches (355.6 to 1828.8 mm)

http://www.epson.com/support
http://www.epson.ca/support
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Color depth Color
• 48 bits per pixel internal (16 bits per pixel per color internal)
• 24 bits per pixel external (8 bits per pixel per color external)
Grayscale
• 16 bits per pixel internal
• 8 bits per pixel external
Black and white
• 16 bits per pixel internal
• 1 bit per pixel external

Interface One USB 2.0 port (Hi-Speed)
IEEE802.11b/g/n (DS-80W)
(You cannot use a USB and network connection at the same time
[DS-80W].)

Light source RGB LED

Parent topic: Technical Specifications

Dimension Specifications
Height 1.4 inches (34.3 mm)
Width 10.7 inches (272 mm)
Depth 1.9 inches (47 mm)
Weight DS-70:

0.6 lb (270 g)
DS-80W:
0.7 lb (300 g)

Parent topic: Technical Specifications
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Electrical Specifications
Scanner

Note: Check the label on the scanner for voltage information. Power consumption varies depending on
operating conditions.

Rated input voltage DC 5 V
Rated input current 0.5 A
Power consumption
(approximate)

DS-70:
Operating: 2.3 W
Ready mode: 1.1 W
Sleep mode: 0.5 W
Power off mode: 0.1 W or less
DS-80W (connected via USB):
Operating: 2.7 W or less
Ready mode: 1.6 W
Sleep mode: 1.2 W
Power off mode: 0.2 W or less
DS-80W (connected via Wi-Fi with fully charged battery):
Operating: 3.1 W or less
Ready mode: 2.5 W
Sleep mode: 1.9 W
Power off mode: 0.2 W or less

Battery (DS-80W)

Type Li-ion
Rated voltage 3.6 V
Rated capacity 1140mAh
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Charging time USB 2.0 port: 3.5 hours (approximately)
(USB charging time with scanner turned off; if the scanner is turned
on, charging takes longer.)

Number of scans (fully charged
battery)

Approx 300 (continuous feed in automatic feeding mode at 300 dpi
[color] via Wi-Fi)

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 41 to 95 °F (5 to 35 °C)

Charging: 46 to 95 °F (8 to 35 °C) [DS-80W]
Storage: –13 to 140 °F (–25 to 60 °C)

Humidity
(non-condensing)

Operating: 10 to 85% RH
Storage: 10 to 90% RH

Operating conditions Ordinary office or home conditions

Note: Avoid operating the scanner in direct sunlight, near a strong light source, in locations subject to
high temperatures, or in extremely dusty conditions.

Parent topic: Technical Specifications

Network Interface Specifications (DS-80W)
Wireless LAN standard IEEE 802.11 b/g/n
Wireless security WPA2-PSK (AES); WPA2 compliant with support for WPA/WPA2

Personal
WEP (64/128 bit)

Frequency range 2.4 GHz
Coordination modes Infrastructure mode

AP mode; not supported for IEEE802.11b
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Maximum radio-frequency
power transmitted

20 dBm (EIRP)

Note: AP mode connection and Wi-Fi connection can be used at the same time.

Parent topic: Technical Specifications

Safety and Approvals Specifications
Scanner

United States Safety: UL60950-1
EMC: FCC part 15 Subpart B class B

Canada Safety: CAN/CSA C22.2 No. 60950-1
EMC: ICES-003 Class B

DS-80W:
This equipment contains the following wireless module:
• Manufacturer: Foxlink Image Technology
• Type: WM294V2-E01
This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).
Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S.) or
this site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions
Battery Safety Instructions (DS-80W)
Restrictions on Copying
Default Delay Times for Power Management for Epson Products
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions
Follow these safety instructions when setting up and using the product.
• Read all these instructions, and follow all warnings and instructions marked on the product.
• Place the product close enough to the computer for the interface cable to reach it easily.
• Do not use with wet hands.
• When connecting this product to a computer or other device with a cable, ensure the correct

orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

• Do not insert objects into any opening as they may touch dangerous voltage points or short out parts.
Beware of electrical shock hazards.

• Place the product on a flat, stable surface that extends beyond the base of the product in all directions.
If you place the product by the wall, leave at least 3.9 inches (10 cm) between the back of the product
and the wall.

• Do not subject the product to physical impacts or drop the product.
• Do not place or store the product outdoors, in a car, near excessive dirt or dust, water, heat sources,

or in locations subject to shocks, vibrations, condensation, high temperature or humidity, direct
sunlight, strong light sources, or rapid changes in temperature or humidity.

https://epson.com/recycle-program
https://www.epson.ca/recycle
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• Never disassemble, modify, or attempt to repair the product or a product option by yourself except as
specifically explained in this guide.

Caution: Radio waves from this product may adversely affect the operation of medical equipment,
airplanes, or automatically controlled devices, such as pacemakers, automatic doors, or fire alarms.
When using this product near such devices or inside a medical facility, follow the directions from
authorized staff members at the facility, and follow all posted warnings and directions on the device to
avoid causing an accident (DS-80W).

USB
• Use only the USB cable supplied with your product. Using any other USB cable could cause fire,

electrical shock, or injury.
• The USB cable is designed for use with the product with which it was included. Do not attempt to use it

with other electrical devices unless specified.
• The USB cable should be placed to avoid abrasions, cuts, fraying, crimping, and kinking.
• Do not place objects on top of the USB cable and do not allow the cable to be stepped on or run over.

Be particularly careful to keep the USB cable straight at the end.
• If you are not going to use the product for a long period, unplug the USB cable from the computer.
• Unplug the product and the USB cable, and refer servicing to qualified service personnel under the

following conditions: Liquid has entered the product; the product has been dropped or the case has
been damaged; the product does not operate normally or exhibits a distinct change in performance.
(Do not adjust controls that are not covered by the operating instructions.)

LCD Screen
• The LCD screen may have uneven brightness or a few small bright or dark spots. This is normal and

does not indicate damage.
• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash

them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

• Do not press too hard on the LCD screen or subject it to heavy impacts.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson

for support.
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• Do not subject your product to sudden changes in temperature or humidity; this may cause
condensation to develop inside the LCD screen and degrade its performance.

Parent topic: Notices

Battery Safety Instructions (DS-80W)
• If the battery is not fully charged within the specified time, stop charging. Otherwise, the battery could

become hot, emit smoke, rupture, or catch fire.
• Do not place the product in a microwave oven or a high-pressure container. Otherwise, the battery

could become hot, emit smoke, rupture, or catch fire.
• If battery acid gets into your eyes or on your skin, immediately rinse the affected area thoroughly with

water without rubbing and seek medical treatment.
• If battery acid leaks from a battery, or the product emits a bad odor, move the product away from

flammable objects immediately. If the product is not moved, electrolytes leaking from the battery
become hot, emit smoke, rupture, or catch fire.

• Do not subject the scanner to physical impacts or drop the scanner. Otherwise, the battery could leak
or the protection circuit in the battery could be damaged. As a result, the battery could become hot,
emit smoke, rupture, or catch fire.

• Do not use or place the product in temperatures exceeding 140°F (60°C), such as near a fire or a
heater. Otherwise, the plastic separator could melt and the individual cells could short-circuit. As a
result, the battery could become hot, emit smoke, rupture, or catch fire.

• Do not use the product if it is leaking or damaged in any way. Otherwise, the battery could become
hot, emit smoke, rupture, or catch fire.

• Do not leave the product in a vehicle. Otherwise, the battery could overheat.
• Always charge the battery within an ambient temperature range of 46°F to 95°F (8°C to 35°C).
Parent topic: Notices

Restrictions on Copying
Observe the following restrictions to ensure responsible and legal use of your scanner.
Copying of the following items is prohibited by law:
• Bank bills, coins, government-issued marketable securities, government bond securities, and

municipal securities
• Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage
• Government-issued revenue stamps, and securities issued according to legal procedure
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Exercise caution when copying the following items:
• Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes,

concession tickets, etc.
• Passports, driver's licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note: Copying these items may also be prohibited by law.

Restriction on disassembling and decompiling
You may not disassemble, decompile, or otherwise attempt to derive the source code of any software
included with this product.
Parent topic: Notices

Default Delay Times for Power Management for Epson Products
This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
Parent topic: Notices

Binding Arbitration and Class Waiver
1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS
1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.
1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
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arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.
1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3131 Katella Ave., Los
Alamitos, CA 90720 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.
1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.
1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.
1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the
selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad

http://www.jamsadr.com
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delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.
You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.
a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").
(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.
(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.
b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.
c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.
d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).
e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section

http://www.jamsadr.com


114

1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.
1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).
1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
Parent topic: Notices

Trademarks
EPSON® and Epson Smart Panel® are registered trademarks and EPSON Exceed Your Vision is a
registered logomark of Seiko Epson Corporation.
Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.
Apple, App Store, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other
countries.
Google® is a registered trademark, and AndroidTM and Google PlayTM are trademarks of Google LLC.
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General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Copyright Attribution
Parent topic: Notices

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler



116

Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (I) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Copyright Attribution
© 2022 Epson America, Inc.
3/22
CPD-56112R2
Parent topic: Copyright Notice
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